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Annotation. Research of certain aspects of using a digital elevation model 

(DEM), their classification and methods of obtaining in the Civil 3D software is 

presented in this article. A land plot with vegetation and the building of the educational 

building of the NULES of Ukraine was used as an object for the study. The analysis of 

aerial photography materials of the territory of the research object is carried out. A 

digital point cloud was created, which was taken as a basis for the further construction 

of digital elevation models. 

Сlassification of surfaces in the Civil 3D software is offered in article. An 

algorithm for the formation of plane components and data filling is considered. 

Highlighted the problems that arise in a robot with a cloud of points and surface 

formation using Autodesk ReCap and Civil 3D. The main advantages and 

disadvantages of building a relief on the basis of point clouds formed on the basis of 

aerial photography of the terrain are shown. Attention is focused on the main ways to 

reduce the identified shortcomings. The functionality and capabilities of Civil 3D and 

Autodesk ReCap software, as well as the features of constructing surfaces based on 

different initial data, are considered. 
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The comparison of the DEM (generated using the Autodesk Civil 3D software) 

and the topographic plan (generated as a result of tacheometric survey) is given. 

Key words: photogrammetry, digital elevation model, Civil 3D, point clouds, 

coordinate geometry points. 

Introduction. Digital elevation models are widely used in solving a wide range 

of issues in topography and land management. Many companies use 3D elevation 

models for improving the visualization of the area and for validation of design 

decisions. The advantages of the volumetric representation of the relief are obvious: 

clarity, ease of use and a decreasing the likelihood of errors due to the human factor. 

A digital elevation model (DEM) is a representation of the topographic (earth) 

surface during computer processing of the results of engineering and geodetic works. 

With the help of a digital elevation model, such applied problems as building contours, 

obtaining longitudinal and transverse profiles, calculating the volume of earth masses, 

etc. are solved. The processes of surface modeling are taken into account when 

designing master plans; using a digital 3D model of the existing relief. Due to using 

digital elevation it is possible to solve the problems of calculating and optimizing the 

volumes of the moved soil And for the successful and effective implementation of the 

projects being created, whether it be a master plan or a road project, it is necessary to 

present the design solution in the form of a digital 3D model of the projected surface 

relief. This is due to the fact that such data are an objective basis for ensuring the 

operation of automatic control systems and making informed decisions. Therefore, the 

task of creating and using digital surface models moves from a purely technical plane 

and forms an expert interest in the formation of design solutions and territory 

management. 

Analysis of recent research and publications. Research on this topic was 

carried out by many authors, in particular: Bartolomey Shipulya [1] investigated the 

process of creating a digital elevation model in the ArcGIS software; Kostin A. V. - 

Methods for creating digital elevation models and directions of use in the ArcGIS 

software [3]; Ravi P. Gupta considered the formation of DEM for raster GIS [4]; 

Burshtynskaya Kh. V. performed a comparative analysis of the accuracy of DEM 

construction using the Surfer software package and the ArcGIS geographic information 



system [2]. They have developed methods for constructing DEM and various methods 

for creating 3D models. 

The issue of forming a digital elevation model and its applications remains 

relevant, since there are quite a lot of software tools with the help of which DEMs can 

be built, which creates the preconditions for their analysis and objective assessment 

when solving special problems. 

The purpose of the researching is an analyzing of the theoretical and 

methodological foundations of creating a DEM in the Autodesk Civil 3D software 

package based on aerial photography materials. 

Research methodology and methods. The topographic method and the method 

of scientific comparison are used in this work. A computational method was applied 

for determination the mean square error of the medial deviation of the curve. 

Comparative method was used for analyzing the topographic plan and DEM. 

Experimental surveys from UAVs and ground surveys was applied. For obtaining the 

possibility of constructing surfaces, such software tools as: Pix4D, ReCap, Civil 3D 

were used. 

In the process of forming the initial data for the implementation of the study, a 

Phantom 4 Pro UAV was used. The camera of which drone (not a calibration camera 

for topographic aerial photography purposes, but can be used to solve special problems 

with an acceptable error) has the following technical characteristics: 

• Matrix: 1 '' CMOS 

• Number of effective pixels: 20 MP 

• Lens: Angle of view 84 °, 24mm (35mm format equivalent), f / 2.8 - f / 11, 

autofocus 1m - ∞ 

• ISO range: 

• Mechanical shutter speed 8 - 1/2000 s 

• Electronic shutter speed: 8 - 1/8000 s 

Main part. To implement the stated goal of the study, it is necessary to carry 

out a theoretical review of the concept of DEM, their components and purpose. 

A DEM is a raster representation of a continuous surface and typically refers to 

the surface of the Earth. The accuracy of this data is primarily determined by the 



resolution (the distance between sample points). Other factors affecting accuracy are 

the data type (integer or floating point) and the actual sampling of the surface when the 

original DEM was created. 

The surface includes the following components: 

 points; 

 polygons (triangles); 

 borders; 

 horizontally; 

 grid. 

Digital elevation models allow the following operations: 

 obtaining information about morphometric parameters (height, slope, 

slope exposure) at any point of the model; 

 analysis of slope steepness and exposure, construction of corresponding 

maps on the fly; 

 generation of contours; 

 construction of cross-sectional profiles of the relief in the direction of a 

straight or broken line; 

 analysis of surface runoff; 

 generation of thalweg and watershed networks; 

 calculation of volumes; 

 calculation of surface areas; 

 calculation of flooding levels and areas; 

 construction of three-dimensional terrain models with rendering 

capabilities and surface draperies as vector objects (hydraulic network, 

roads, settlements, landscape maps, etc.) and raster layers (topographic 

maps, remote sensing data); 

 creation of a video image of the "flight" over the surface of the model 

 along a given route (virtual reality systems); 

 analysis of visibility zones from a given point or viewpoints and 

construction of corresponding maps or three-dimensional models; 



 transformation of the original model by adding new data. [6] 

In the course of the researching, for creating the surface, the Civil 3D software 

will be used. The surface will be formed in this software as a three-dimensional 

geometric representation of the land. A surface is made up of data points that connect 

to form triangles or a mesh of the surface. 

You can turn the visibility of any of the surface components on or turn it off. 

Thus, for example, by creating a design surface and turning on the display of contours 

on it, you can see the vertical layout of the site. This planning will be dynamic and 

responsive for all subsequent surface changes. 

Typically, a Civil 3D surface is first created empty and then filled with 

construction data. Such data can be: 

 Coordinate geometry points COGO; 

 Horizontal lines, breaklines; 

 Simple AutoCAD objects (points, lines, blocks, texts, 3D-faces, 

polyhedra); 

 Borders; 

 DEM files (DEM files are designed to store and transfer large amounts of 

topographic information about the relief in the form of XYZ coordinates 

of grid nodes with a constant step). 

Surfaces in Civil 3D are of the following types: 

TIN surfaces. Such a surface is based on triangles that connect the points of the 

surface closest to each other, forming a triangulation network. The elevation of any 

point on the surface is determined by interpolating the elevations of the vertices of the 

nearest triangles. This is the most common and frequently used type of surface; 

Mesh surfaces. Such a surface is based on points on a grid with a constant step. 

Such surfaces are used for displaing large areas with low detail; 

TIN surfaces for volume. A composite surface constructed from the difference 

in elevation between the points of the reference surface and the reference surface. Most 

often, the surface of the existing land is compared with the design one to calculate the 

total volume of earthworks; 



Mesh surfaces for volume calculation. The elevations of such a surface are 

calculated as the difference between the upper and lower surfaces, with points on the 

grid. 

When creating a surface in the Civil 3D software [6], the result of processing 

aerial photographs of educational building No. 6 of NULES, which is a point cloud, 

was used as the initial data in the Pix4D software. It is worth noting that before 

exporting in the Pix4D program, it is necessary to classify points and a separate group 

of points intended for export, which does not include objects that can create errors 

when constructing contours (for example, bushes, trees, houses, etc.). Civil 3D 

supports this functionality and allows you to specify the desired point group or groups 

when importing a point cloud from an external file. 

Figure: 1 Export point cloud. Pix4D  

However, Civil 3D does not directly process .xyz files. For compatibility 

reasons, the ReCap software is included with Civil 3D. This application can be 

launched directly from the Civil 3D program interface (Insert menu on the toolbar). 

This application provides the ability to convert the source data format to a format 

compatible with Civil 3D: .rcp and .rcs. To perform format conversion in ReCap 

software, you need to do the following: select "scan project", then, in the menu that 

opens, select the location of the file. The next step is to select the file extension .xyz - 

then "index scans" - "import files" - "launch project". As a result of these actions, the 

point cloud will be imported into Civil 3D. 



Autodesk ReCap provides functionality for filtering point, if at the previous 

stage points, that introduce errors when constructing contours, were not removed or 

filtered into a separate group. There are two ways for removing them: 

• by using the Fence tool; 

• by dividing objects into regions (areas), select the necessary points into a 

separate area, and then export it (Fig. 3); 

Figure: 2 Point cloud in Autodesk ReCap 

Figure: 3 Creating Point Regions in Autodesk ReCap 

In this work, the second option was used. The points that introduced an error 

during the construction were assigned to a separate region. The visibility of this region 

was subsequently turned off, and the remaining points as a result were exported to a 

separate file. This file was loaded into Civil 3D using the Insert menu. 

For creating a DEM according to the loaded cloud, on the "Home" tab, select the 

"Create surface from point cloud" option. As a result, the program created the surface 

presented in Figure 6.  

Figure: 4 Creating a Surface from a Point Cloud in Civil 3D Software 



The figure shows that the surface built by the program contains errors.  

Unfortunately, it is almost impossible to avoid them by filtering points at the previous 

stages, especially if there is a lot of vegetation on the treated area. 

Figure: 5 Surface created from point cloud  Figure: 6 Contour errors 

Therefore, the terrain will be constructed using COGO points that will be 

manually generated. This will minimize errors. Coordinate Geometry Points (COGOs) 

are AutoCAD Civil 3D objects that can be displayed in a drawing and that can be 

manipulated graphically. The appearance of points is customizable using point labels 

and point styles. To create points on the "Home" tab, select the "Create points" option 

in the "Points" menu, specifying "Along the polyline / horizontal" as the "Surface" 

parameter. Then the program will offer to enter additional parameters for the created 

points: 

• distance between points, 

• point description 

• the contour on which the point is to be drawn. 

In the description of points, you can assign these points to separate groups, which 

is convenient for setting the display style for this group of points, as well as when filling 

the virtual surface with data from the current group of points. 

To create points manually, Civil 3D provides a tool "create points manually". 

When this tool is selected, clicking on the left mouse button will create a point at the 

selected place, with the specification of its description and specifying the height. Points 

are deleted using the delete key. 



Figure: 7 Creating COGO points along contours 

For effective work, it is proposed to combine commands: automatically add 

points for common horizontal filling, and then manually add points where they are 

needed.  

Figure: 8 Creating COGO Points 

Figure: 9 COGO point group properties 

To change the style of a group of points in the "Navigator" panel, select the 

required group of points, having previously opened all the existing ones, and then by 

pressing the RMB call the menu, where select the option "Properties" 

It is worth noting that for points that are barely added or removed from the group, 

the new style settings may not apply. In order to avoid such a scenario in the same 



menu, caused by pressing RMB, you need to periodically after each adding or 

removing a point from the group use the "Update" option to keep the group of points 

up to date. 

As a result of the work done, it is necessary to obtain a group of points describing 

the surface being built more accurately than in the previous stages. 

Figure: 10 Created COGO points 

For creating the final surface, use the "Surface" option on the "Home" tab. In the 

menu that opens, it is need to specify the surface information: type, name, description, 

style and material for rendering (Fig. 11). As a result of these actions, the surface will 

be created and displayed in the "PathFinder". At this moment it is only virtual: the next 

step is to fill it with data. To do this, on the "Navigator" tab, in the menu of the selected 

surface, it is necessary to add a previously created group of points by means of the 

option "Point groups" - "Add" in the "Definitions" menu. In the dialog box that opens 

(Fig. 12), you should specify the desired group of points. Pressing the "OK" button to 

complete the surface filling process. As a result of the work done, the program will 

draw the created relief. 

Figure: 11 Surface creation 



Figure: 12 Filling the surface with data (COGO point group) 

As a result, we get the surface and change the display style to shaded: 

Figure: 13 Surface based on COGO points 

Comparing our relief and the topographic plan (Fig. 14) created as a result of 

tacheometric survey, you can notice the difference in the tortuosity of the contours. 

Why there are differences at all, firstly, it may be insufficient data availability or data 

imperfection, since the point cloud that we used was not perfect and contained gaps. 

Secondly, the survey with a total station is also not ideal. During its implementation, 

there are different factors of influence and types of errors, which to a certain extent 

affect the results. 

That is, there are always some errors. And, of course, it is best when the results 

of several types of surveys are available, after analyzing them, you can achieve the 

desired and more accurate result. 

 

 



Figure: 14 Topographic plan 

 

Fig. 15 Medial curve deviation 

In order to determine how much the contours are formed on the basis of data 

from the point cloud and the contours are formed on the basis of COGO points, to 

assess the accuracy of the work and the possibility of using the algorithm for special 

tasks in land management, we use the coefficient of variation, which shows the degree 

of variability in relation to the average sampling. 

The coefficient of variation is the ratio of the standard deviation 𝑠0 to the 

arithmetic mean 𝑠, expressed as a percentage: 

𝑐𝑣 =
𝑠0

𝑠
 

The arithmetic mean deviation is determined by the formula: 

𝑠 = ∑
𝑦𝑖 − 𝑦′

𝑖

𝑛

𝑖=1

𝑛

 

where: 𝑠 - arithmetic mean deviation; 



n is the number of samples; 

𝑦𝑖- value along the Oy coordinate of the function graph, corresponding to 𝑥𝑖 (𝑖-

th sample) on the final horizontal; 

𝑦′
𝑖
 - value along the Oy coordinate of the function graph, corresponding to 𝑥𝑖 

(𝑖-th sample) on the previous horizontal. 

𝑠  =  2,076037 

The mean squared error is determined by the formula: 

𝑠0 = √
1

𝑛 − 1
∑(𝑦𝑖 −  𝑠)2

𝑖=1

𝑛

 

where: 𝑠0 - mean squared error; 

n is the number of samples; 

𝑦𝑖- value along the Oy coordinate of the function graph, corresponding to 𝑥𝑖 (𝑖-

th sample) on the final horizontal; 

𝑦′
𝑖
 - value along the Oy coordinate of the function graph, corresponding to 𝑥𝑖 

(𝑖-th sample) on the previous horizontal. 

𝑠0 = 0.144281 

Having received the value of the arithmetic mean and standard deviation, it is 

possible to determinate the coefficient of variation: 

𝑐𝑣 =
0,144281

2,076037
= 5,23% 

Variability is considered weak if 𝑐𝑣 <10%. If 𝑐𝑣 is from 11-25%, then its value 

is average. And this value is significant at 𝑐𝑣> 25%. Thus, according to the formula 

above, the variability (deviations) of contour lines is weak, which makes the described 

DEM method based on aerial photography materials acceptable for solving a certain 

range of land management and topography problems. 

Conclusion. Despite the seeming simplicity of the relief as an object of 

modeling, practice offers a large number of methods and technologies for the formation 

of DEM. The variety of types of data sources for creating DEMs is caused by a variety 

of methods for obtaining and organizing primary data and their derivatives. 



The variety of software, in which it is possible to build a DEM, only emphasizes 

the relevance of this topic. In this paper, Autodesk Civil 3D is the most detailed. The 

description of the surface construction process allows you to determine its advantages 

and disadvantages. The advantage of Civil 3D, of course, is its wide functionality. The 

downside is the processing time. The point cloud used in the research process contains 

about 2500000. Points, its processing time is about 30-50 minutes. After completing 

the formation of the surface, user need to wait about 20 minutes to download the work 

results. After this time, it becomes possible to continue working in this software. 

It is worth noting that at the stage of surface creation, the contours obtained from 

the point cloud are rather inaccurate. Moreover, many small closed contours are created 

by software on this stage. Errors when constructing a surface occur quite often in the 

Civil 3D program. However, it is possible to correct these errors automatically. But in 

the analyzed case (Fig. 6) it is rather difficult to eliminate them. Therefore, as an 

alternative solution to the problem, the construction of COGO points is used. 
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Бутенко Є.В., Боровик К.В., Герин А.Р., Губкін Б.А. 

ФОРМУВАННЯ ЦИФРОВОЇ МОДЕЛІ РЕЛЬЄФУ ЗА 

МАТЕРІАЛАМИ АЕРОФОТОЗЙОМКИ В ПРОГРАМНОМУ ЗАСОБІ 

CIVIL 3D 

Анотація. У статті досліджено окремі аспекти використання цифрової 

моделі рельєфу (ЦМР), їх класифікація та способи отримання в програмному 

засобі Civil 3D. Проаналізовані матеріали аерофотозйомки території об’єкта 

дослідження (земельна ділянка із рослинним покривом та будівлею навчального 

корпусу НУБіП України) із подальшою обробкою результатів вимірювання, за 
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допомогою програмного засобу Pix4D, формування хмари точок, яка і була взята 

за основу для побудови цифрової моделі  рельєфу. 

У статті запропонована класифікація поверхонь у програмному засобі 

Civil 3D, формування їх компонентів та наповнення даними. Проведено 

порівняння отриманих поверхонь залежно від вихідних даних. Проілюстровані 

помилки, які виникають при роботі з хмарою точок та формуванні поверхні з 

використанням програм Autodesk ReCap та Civil 3D. Виявлені основні переваги 

та недоліки побудови рельєфу на основі сформованих за матеріалами 

аерофотозйомки місцевості хмар точок, і запропоновано спосіб їх усунення. 

Розглянуті функції і можливості програм Civil 3D та Autodesk ReCap та 

особливості побудови поверхонь на основі різних вихідних даних.  

Наведено порівняння ЦМР (сформованої за допомогою програмного засобу 

Autodesk Civil 3D) та топографічного плану (сформованого у результаті 

тахеометричної зйомки). 

Ключові слова: фотограмметрія, цифрова модель рельєфу, Civil 3D, 

хмара точок, точки координатної геометрії. 
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Аннотация. В статье исследовано отдельные аспекты использования 

цифровой модели рельефа (ЦМР), их классификация и способы получения в 

программном средстве Civil 3D. Проанализированы материалы 

аэрофотосъемки территории объекта исследования (земельный участок с 

растительным покровом и зданием учебного корпуса НУБиП Украины) из 

дальнейшей обработкой результатов измерения, с помощью программного 

обеспечения Pix4D, формирование облака точек, которое и было взято за 

основание для построения цифровой модели рельефа. 



В статье предложена классификация поверхностей в программном 

обеспечении Civil 3D, формирование их компонентов и наполнение данными. 

Проведено сравнение полученных поверхностей в зависимости от исходных 

данных. Проиллюстрированы ошибки, которые возникают в роботе с облаком 

точек и формирование поверхности с использованием программ Autodesk ReCap 

и Civil 3D. Обнаружены основные преимущества и недостатки построения 

рельефа на основе сформированных по материалам аэрофотосъемки 

местности облак точек, и предложено способ их устранение. Рассмотрены 

функции и возможности программ Civil 3D и Autodesk ReCap, а также 

особенности построения поверхностей на основе разных исходных данных. 

Приведено сравнение ЦМР (сформированной с помощью программного 

средства Autodesk Civil 3D) и топографического плану (сформированного в 

результате тахеометрический съемки). 

Ключевые слова: фотограмметрия, цифровая модель рельефа, Civil 3D, 

облака точек, точки координатной геометрии. 

 


